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Chapter 1

Prepare for Installation

Prepare for Installation of Connect:Direct for Windows
Before you install Connect:Direct for Windows, you must first ensure that all of the system hardware
and software, including third-party software, are configured. Pre-installation tasks include the
following:
• Ensure the system meets product hardware and software requirements.
• Define users for Windows.
• Configure and test TCP/IP or SNA connectivity as needed.
• Install and configure SQL Server for database support as needed.
• Install and configure SNMP as needed.
• If you plan to use NT Broadcast to send user notification messages, ensure that NT Broadcast

is configured.
• Complete the installation worksheets.

Requirements for Copying Files To and From Network Servers
When you are ready to begin creating Processes, be aware that Connect:Direct allows you to share
information across computers. This means that all of the data does not have to be located on the
Connect:Direct server. Observe the following requirements to enable copying files among network
servers:
• Files to be copied must reside on a file server that is accessible by Connect:Direct for Windows.
• You must provide a valid user ID and password for the file server where the files reside. Use

a local node ID when you submit a Process on the local node; use a remote node ID when you
submit a Process on a remote node.You can supply the information as part of the process
statement or the submit command or use the Login Connection Utility to provide this
information.

• If a Process has multiple copy steps, the local node ID or remote node ID parameter must be
appropriate for each file server from which, or to which you transfer a file. This method is
necessary because the parameters apply to the Process as a whole and not to individual copy
steps.
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Chapter 1 Prepare for Installation

• Specify the Universal Naming Convention (UNC) form of the file name if the file is not on a drive
directly connected to the same Windows server as Connect:Direct. If the file is on the Windows server
where Connect:Direct is installed, you can specify the drive letter. The UNC name format is:
\\servername\share point name\filename

• The servername is the name of the Windows server where data resides.
• The share point name represents the name under which the remote Windows server

shares the directory you want to access.
• The filename specifies the name of the file and any subdirectories.

Configure Windows User Privileges
Connect:Direct for Windows must be installed by a Windows Administrator. However, the ongoing
administration of Connect:Direct for Windows requires only that the administrator be a member of the
Windows Users group and be defined in the Connect:Direct for Windows User Authorities with
administrative privileges based on the admin template.

After Connect:Direct for Windows is installed, attach to Connect:Direct for Windows as sysadmin and
add a user (or users) as a Connect:Direct for Windows administrator (for example, cdadmin) with the
user right “Log on locally.” Then, delete “sysadmin” from the Connect:Direct for Windows User
Authorities.

Refer to the Microsoft Windows system documentation for instructions on setting up an administrator
account. Refer to the Connect:Direct for Windows System Guide for information on configuring user
authorities.

Customize a Connect:Direct Logon Account

Connect:Direct for Windows is installed under the Local System account.

If you want to create a custom account for Connect:Direct, assign this account the following privileges:
• Log on as service—Set this privilege to allow a Windows service to run in the context of the

specified user instead of running in the context of the local system account.
• Replace a process level token—Turn on this privilege to allow Connect:Direct for Windows

to submit Processes on behalf of logged on users.
• Be a member of the Local Administrator Group—If you want to allow the node to update its

entry in Active Directory, the account must also be a member of the Enterprise Admin group.
• Secure+ directory—Give the account full permissions to the Secure+ directory.

Note: These privileges are stored locally, even if the computer is a member of a domain. As a
result, privileges cannot be set on the domain controller and granted to all computers on
the domain.

Note: Enabling the option "Allow service to interact with desktop when running
Connect:Direct under the local System account" represents a security risk and may allow
a user to gain access to services that interact with the desktop.
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Configure TCP/IP Connectivity

Once you have created the account, you assign it as the account for Connect:Direct. To identify the
custom logon account:

1. Select Start > Settings > Control Panel > Administrative Tools > Services.

2. Double-click the Connect:Direct server.

3. Click the Log On tab.

4. Select This account to identify the custom logon account.

5. Type the account name to use for logging onto Connect:Direct, or click Browse and double-click
the user account to use for logging on.

6. Type the password in the Password box.

7. Confirm the password in the Confirm password box.

8. Click OK.

Configure TCP/IP Connectivity
To enable TCP/IP connectivity, configure each computer with a valid IP address, IP subnet, and IP
gateway. If the communications partner is on another subnet or network and a firewall is between the
communications partner and the Windows computer, verify that the Access Control Lists (ACLs) are
correctly configured. Contact your Firewall/Security Administrator for more information on
configuring the ACLs for your firewall.

Connect:Direct for Windows Installation Worksheet
Complete this worksheet before you install Connect:Direct for Windows.

Decision Choices Additional Information

What Connect:Direct software do
you plan to install?

• Connect:Direct Requester

• Connect:Direct Server

• Connect:Direct Secure+
Option

Choose the installation directory. (X
represents the drive letter.)

• Accept the default
installation directory - X:
\Program Files\Sterling
Commerce\Connect:Direct
4.5.00

• Change the installation
directory

• Install on a network drive

• Place an icon on a desktop
to perform the installation
the first time the application
is opened.
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Decision Choices Additional Information

Name this Connect:Direct node - The
default local node name is the name
of the Windows computer.

Note To change the local node
name after the product is
installed, you must reinstall
Connect:Direct for
Windows.

Identify the location of the license
management file.

You will also need to identify the
number of sessions you are licensed
for.

Identify the database software • MySQL

• Microsoft SQL Server—
Windows Authentication

• SQL Server with Mixed
Mode Authentication

If security is implemented on
Microsoft SQL Server—Windows
Authentication, create a valid user ID
and password and a CREATE
TABLE privilege within the database.

If Integrated security is implemented
on SQL Server with Mixed Mode
Authentication, ensure that the user
group that the Connect:Direct
installer belongs to has CREATE
TABLE privilege within the
Connect:Direct database.

Identify TCP/IP communication
information

Identify Node-to-Node IP Address,
Node-to-Node Port, User Interface IP
Address, User Interface Port

Identify UDT communication
information

Identify Node-to-Node IP Address,
Node-to-Node Port, User Interface IP
Address, User Interface Port

Identify additional components • APPC Connectivity - SNA.
Identify LU Name, Net ID,
Mode Name.

• Process Notification.
Specify NT Broadcast or
SMTP. If SMTP, specify
Host Address, Host Port
(default is 25), and Sender.

• Load an Existing Network
Map. Identify the fully
qualified pathname for the
MAP.CFG.

• Load Existing User
Authorities. Identify the Fully
qualified pathname for the
USER.CFG.

Install and Configure Database Software
During the Connect:Direct for Windows installation, you are prompted to choose MySQL or SQL
Server as the database type. The database is used to log Process statistics information, internal
messages, and the Process control queue. Determine which software you plan to use as the database
software.
• If you plan to use MySQL as the database, no preinstallation configuration is required.
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Automate the Connect:Direct for Windows Installation

• If you plan to use SQL Server as the database, install the database software on the local
computer, or a network drive or remote computer that is accessible from the locally installed
Connect:Direct node. Use Control Panel to set the SQL Server to start automatically at Start >
Settings > Control Panel > Administrative Tools > Services.

Automate the Connect:Direct for Windows Installation
You can automate Connect:Direct for Windows installations using an initialization (INI) file. You can
implement automated installations by specifying a path to the INI file from the command line of the
Windows setup. See About Silent Installations for information about automating installations.

Configure SNA Connectivity
If you plan to use SNA network communications connectivity with Connect:Direct for Windows, install
and configure the SNA software before installing Connect:Direct for Windows. Use the SNA
Configuration Worksheet to identify the parameters necessary to configure SNA.

In addition, create an active connection between the local and remote nodes. Connect:Direct for
Windows requires the following information for the local and remote SNA networks in order to
configure a peer- or host-based partner SNA connection:
• Network name
• Mode name (local system only)
• Control point name
• Node ID
• Network address (remote system only)
• LU name and LU alias name (these names may be the same value; Connect:Direct uses the LU

alias name)

Note: Connect:Direct for Windows supports only independent LU6.2.

Refer to the SNA Server/Host Configuration Worksheet when mapping SNA connection parameters
between Connect:Direct for Windows and a host system.

Note: Consult the SNA product documentation or contact your SNA vendor for any questions about
configuring the SNA communications software.

SNA Configuration Worksheet
Use this worksheet to identify the parameters necessary to configure SNA. Make copies of this
worksheet for each SNA configuration. See the z/OS Network Map Example for VTAM for SNA Server
configuration examples.
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Node Information Needed Additional Information

Local Node Decide the following:

• Connect:Direct Node Name

• LU Alias Name

Get the following information from
your SNA administrator:

• LU Name

• Network Name

• Mode Name

• Control Point Name

• Node ID

The LU Alias name is a user-defined
name that references the LU name
defined in the local SNA network.
This value can be the same as the
actual LU name.

Remote Node Get the following information from
your trading partner:

• Connect:Direct Node Name

• LU Alias Name

Get the following information from
your SNA administrator:

• LU Name

• Network Name

• Control Point Name

• Node ID

• Network Address

The LU Alias name is a user-defined
name that references the LU name
defined in the remote SNA network.
This value can be the same as the
actual LU name. Obtain that
information from the SNA
administrator of the remote system.

Sample SNA Configuration
This section illustrates a sample SNA configuration used to connect to Connect:Direct for z/OS. You
provide the following SNA resource definitions during the Microsoft SNA configuration. These values
are derived from VTAM definitions supporting connections between Connect:Direct for z/OS and
Connect:Direct for Windows. Contact the VTAM administrator for the values you need to specify
during SNA configuration.

Windows Parameter Value z/OS

Remote LU Name = M1CDXY2B =APPLID

Local LU Name = M1R01LUA =LU NAME

Network Name = CSDNET =NETID

Mode Name = NDM624K =MODEENT

Remote Control Point Name = CSDSA01 =SSCPNAME

Local Control Point Name = M1RPU01 =PU NAME

Local Connect:Direct Node Name = SS.DUB.USER1 =ADJACENT.NODE

Remote Connect:Direct Node Name = CDNT0001 =LOCAL.NODE

Local Node ID = 0716200D =XID

Remote Network Address = 4000 7000 6200 =MAC Address
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Sample Connect:Direct for z/OS Network Map Entries

Sample Connect:Direct for z/OS Network Map Entries
The following sample illustrates Connect:Direct for z/OS network map entries for Windows SNA
software running Connect:Direct for Windows.
*****************************************************************
*                                                               *
*                   Connect:Direct NETWORK MAP                  *
*                                                               *
*****************************************************************
*                                                               *
*****************************************************************
* LOCAL NODE                                                    *
*****************************************************************
LOCAL.NODE    =  ((SS.DUB.USER1 M1CDXX2B,, SUPERUSR)          -
           TCQ=  (USER1.R210.TCX                              -
                 USER1.R210.TCQ)                  )
*
ADJACENT.NODE = (PARSESS = (10  2)                            -
                (CDNT0001, M1R01LUA, LU62)                  -
                ENVIRONMENT=NT                              -
                LOGMODE=NDM624K                        )

XCA Token Ring: Switched Net Definitions
The following sample illustrates the major node definitions for an XCA device.
***************************************************
*                                                           *
*                                                           *
*XCA TR   DEFINITION                                        *
*                                                           *
*                                                           *
*CHANGE LOG                                                 *
*                                                           *
***************************************************    
M1R01PU  VBUILD 
TYPE=SWNET,                                                                       
                                                                                                  
X
            MAXGRP=1,              MAXIMUM NUMBER OF UNIQUE GRPNM                    
X
             MAXNO=1               MAXIMUM NUMBER OF UNIQUE DIALNO
*
***
M1RPU01  PU    
ADDR=01,                                                                          
                                                            X
                       
PUTYPE=2,                                                                         
                                                                               X
                       ISTATUS=ACTIVE,                                X
                       DBLK=071,                                      X
                       IDNUM=6200D,                                   X
                       PASSLIM=8,                                     X
                       DLOGMOD=NDM624K,                               X
                       MODETAB=DALLMTAB,                              X
                       SSCPFM=USSSCS,                                 X
                       USSTAB=LSUSSTAB,                               X
                       PACING=7,                                      X
                       VPACING=7,                                     X
                       DISCNT=(NO),                                   X
                       MAXDATA=521,                                   X
                       MAXPATH=2,                                     X
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                       MAXOUT=8
*
M1RPTH0D PATH  GRPNM=M1XG516D,                                        X
                       DIALNO=0011111111111D  DUMMY
*M1ROLUA LU LOCADDR=0, DLOGMODE=NDM6241C
*3270
*
M1R01LU2 LU  LOCADDR=2,DLOGMOD=D4A3290
M1R01LU3 LU  LOCADDR=3,DLOGMOD=D4A3290
*
*LU 6.2 ILU
*

XCA Token Ring: Independent LU Definition
The following sample illustrates the Independent LU definitions included as Cross Domain Resources.
******************************************************************
 VTAM 3.4 CDRSC DEFINITIONS FOR INDEPENDENT LU'S                          *
* 6.2 ILU DEFINITION - XCA TR ACCESS                                      *
*CHANGE LOG:                                                              *
*                                                                         *
*                                                                         *
*                                                                         *
******************************************************************
M1R01CDS VBUILD TYPE=CDRSC
*
M1R01CDS VBUILD TYPE=CDRSC
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5 SESSION CONTROL BLOCKS
M1R01LUB CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01, ADJ LINK STATION                              X
           MODETAB=DALLMTAB, LOGON MODE TABLE                             X
           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUB CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUC CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM622K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUD CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM621K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*

XCA Token Ring: Major Node Definition
The following sample illustrates the major node definitions for an XCA device.
*****************************************************************
*                                                               *
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Sample Connect:Direct APPLDEF

* XCA MAJOR NODE                                                *
*                                                               *
* CHANGE LOG:                                                   *
*****************************************************************
M1XCA516 VBUILD TYPE=XCA        XCA MAJOR NODE
*
M1XP5161 PORT  MEDIUM=RING,     TOKEN-RING                      X
               SAPADDR=4,       SERVICE ACCESS POINT ADDRESS    X
               ADAPNO=0,        ADAPTER NUMBER                  X
               CUADDR=516       CHANNEL UNIT ADDRESS
*
M1XG516D GROUP DIAL=YES,        SWITCHED PERIPHERAL NODE        X
               CALL=IN,         DIAL IN AS PER MCDATA           X
               ISTATUS=ACTIVE   ACTIVATED AT GEN
*
M1XL516D LINE  ANSWER=ON        PU CAN DIAL IN
*
M1X516PD PU
*
***

Sample Connect:Direct APPLDEF
The following sample illustrates the application definitions for Connect:Direct for z/OS.
ZZAPPGLP VBUILD TYPE=APPL
*****************************************************************
*         C:D z/OS TEST LU 6.2 ILU APPL DEFINITION              *
*                                                               *
*****************************************************************
*
M1CDXY2B APPL ACBNAME=M1CDXY2B,    VTAM APPLID                  X
            APPC=YES,          LU 6.2 CAPABLE                   X
            AUTH=(ACQ,VPACE),  VTAM AUTHORITY FOR THIS APP      X
            AUTOSES=10,        # OF AUTO CONT WINNER ACTIVATES  X
            DDRAINL=ALLOW,     DRAIN ALLOWED FOR CNOS 0         X
            DLOGMOD=NDMLM1K,   DEFAULT MODE TABLE ENTRY         X
            DMINWNL=10,        MIN CONT WINNER FOR LOCAL LU     X
            DMINWNR=10,        MIN CONT WINNER FOR REMOTE LU    X
            DRESPL=ALLOW,      APPL WILL DO SESSION DEACTIVATES X
            DSESLIM=20,        MAX # OF ALLOWED SESS FOR MODE   X
            EAS=509,           APPROX # OF CONCURRENT SESSIONS  X
            MODETAB=DALLMTAB,  MODE TABLE NAME                  X
            VPACING=7          DEFAULT RECEIVE PACING VALUE
*

Sample Connect:Direct MODEENTS (Mode Definitions)
The following sample illustrates the mode definition entries for an independent LU.
*****************************************************************
*                                                               *
*                      LU 6.2 WITH 4K RU’S                      *
*                                                               *
*****************************************************************
NDM624K  MODEENT LOGMODE=NDM624K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               SECPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
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               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’8989’,                               *
               PSERVIC=X’060200000000000000000300’            *
*                        0 1 2 3 4 5 6 7 8 9 1011             
*****************************************************************
*                                                               *
*                      LU 6.2 WITH 2K RU’S                      *
*                                                               *
*****************************************************************
NDM622K  MODEENT LOGMODE=NDM622K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               SECPROT=X’B0’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’8888’,                               *
               PSERVIC=X’060200000000000000000300’            *
*                        0 1 2 3 4 5 6 7 8 9 1011     
*****************************************************************
*                                                               *
*                      LU 6.2 WITH 1K RU’S                      *
*                                                               *
*****************************************************************
NDM621K  MODEENT LOGMODE=NDM621K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               SECPROT=X’B0’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’87

Sample VTAM Start Options (ATCSTRxx)
The following sample represents the VTAM Start Option entries for NETID and SSCPNAME.
*****************************************************************
*                                                               *
*                   z/OS VTAM START DEFINITION                  *
*                                                               *
*****************************************************************
HOSTSA=01,                                                    X
NODETYPE=NN,                                                  X
CONNTYPE=LEN,                                                 X
CPCP=YES,                                                     X
GWSSCP=YES,                                                   X
NETID=CSDNET,                                                 X
SSCPID=15015,                                                 X
SSCPNAME=CSDSA01,                                             X
LISTBKUP=DEFAULTS,                                            X
TNSTAT,NOCNSL,TIME=60,                                        X
PPOLOG=YES,                                                   X
XNETALS=YES,                                                  X
NCPBUFSZ=2048,                                                X
HOTIOTRM=50,                                                  X
IOPURGE=5M,                                                   X
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z/OS Network Map Example for VTAM

MSGLEVEL=V4R1,                                                X
MAINTLVL=9311,                                                X
IOBUF=(750,320,50,,30,100,3000),                              X
CRPLBUF=(500,,0,,25,1),                                       X
LFBUF=(300,,0,,32,1),                                         X
LPBUF=(80,,0,,12,1),                                          X
SFBUF=(40,,0,,34,1),                                          X
SPBUF=(32,,0,,32,1),                                          X
BSBUF=(600,,0,,25,50),                                        X
XDBUF=(55,,0,,5,1)

z/OS Network Map Example for VTAM
The following sample illustrates the use of the VTAM parameters (identified by the alphabetic
characters inside brackets) in a z/OS network map.
LOCALNODE=                        ADJACENT.NODE=(
       (node name[b],                       (node name[a],
       communications name[o],,             communications name[m],,
       superuser password)                  LU62)
       TCQ=(tcxdsn, tcqdsn))                PARSESS=(max[d], default)
                                            ENVIRONMENT=NT
                                            LOGMODE=logmode entry name[c])

Refer to the platform-specific Connect:Direct installation and administration guides for network map
information on other host platforms.

Windows Network Map Example
The following sample illustrates the use of the SNA parameters (identified by alphabetic characters in
brackets) in a Windows network map.
CREATE_SNA_MODE Name(mode [c])
MAXRUsize (MaxRU [e]) MaxPacingSize(7) MaxNetSessLimit(8)
CREATE_SNA_COMMPATH Name(commpathname)
Transport(transport-type) Adapter(0) Address(000000000000)
NetId(netid[f]) PUName() LUName(LUName [m])
ProfileName() LULocAddr(0) Mode(mode[c]) LUSessLimit(8)
CREATE_REMOTENODE Name(remotenodename [b])
LRetry(10) LRetryTime(180) Sretry(10) SretryTime(10) SessPnodeMax(32)
SessSnodeMax(32) DefaultClass(1) RemoteOSEnv(OS/390) NetName(NetName[f])
PartnerName(PartnerName[o]) TPName(NNV2DTF) Mode(mode[c]) CommPath(commpathname)

Access SNA Server Configuration Listing
Use the following Windows SNA Server command to display the configuration and redirect the
information to a file:

snacfg /print>filename

The following sample illustrates the Microsoft SNA server configuration listing for a configured
Windows server using the values listed in the VTAM Sample Definitions:

MODE #INTER /ADD                              \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
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   /AUTOACT:0                                 \
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:Yes                          \
   /PACESENDCNT:7                             \
   /PACERECVCNT:7                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
   /COMMENT:"Interactive"                     \
MODE #BATCH /ADD                              \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
   /AUTOACT:0                                 \ 
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:No                           \
   /PACESENDCNT:3                             \
   /PACERECVCNT:3                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
   /MAXSENDRU:1024                            \
   /COMMENT:"Batch"                           \
MODE #BATCHSC /ADD                            \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
   /AUTOACT:0                                 \
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:No                           \
   /PACESENDCNT:3                             \
   /PACERECVCNT:3                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
   /MAXSENDRU:1024                            \
   /COMMENT:"Batch"                           \
MODE BLANK /ADD                               \
  /SESSIONLIM:8                               \
  /CONWIN:4                                   \
  /CONLOSE:0                                  \
  /AUTOACT:0                                  \
  /AUTOPARTNER:No                             \
  /HIGHPRIORITY:No                            \
  /PACESENDCNT:3                              \
  /PACERECVCNT:3                              \
  /MAXSENDRU:1024                             \
  /MAXRECVRU:1024                             \
  /MAXSENDRU:1024                             \
  /MAXSENDRU:1024                             \
  /COMMENT:"8 Blank chars"                    \
MODE QPCSUPP /ADD                             \
  /SESSIONLIM:64                              \
  /CONWIN:32                                  \
  /CONLOSE:0                                  \
  /AUTOACT:0                                  \
  /AUTOPARTNER:Yes                            \
  /HIGHPRIORITY:Yes                           \
  /PACESENDCNT:7                              \
  /PACERECVCNT:7                              \
  /MAXSENDRU:1024                             \
  /MAXRECVRU:1024                             \
  /MAXSENDRU:1024                             \
  /MAXSENDRU:1024                             \
  /COMMENT:"5250 Mode"                        \
MODE NDM624K /ADD                             \
  /SESSIONLIM:20                              \
  /CONWIN:10                                  \
  /CONLOSE:10                                 \
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  /AUTOACT:0                                  \
  /AUTOPARTNER:No                             \
  /HIGHPRIORITY:No                            \
  /PACESENDCNT:7                              \
  /PACERECVCNT:7                              \
  /MAXSENDRU:4096                             \
  /MAXRECVRU:4096                             \
  /MAXSENDRU:4096                             \
  /MAXSENDRU:4096                             \
  /COMMENT:" "                                \
SERVER CSD-PUBS /ADD                          \
  /CPNAME:M1RPU01                             \
  /NETNAME:CSDNET                             \
  /COMMENT:""                                 \
LINK SNADLC1 /ADD                             \
  /SERVER:CSD-PUBS                            \
  /LINKTYPE:Token                             \
CONNECTION TOKEN1 /ADD                        \
  /SERVER:CSD-PUBS                            \
  /COMMENT:"802.2 Connection"                 \
  /ACTIVATION:OnServerStartup                 \
  /CALLDIRECTION:Both                         \
  /LOCALBLOCKNO:071                           \
  /LOCALNODENO:6200D                          \
  /CPNAME:CSDSA01                             \
  /NETNAME:CSDNET                             \
  /REMOTEBLOCKNO:                             \
  /REMOTENODENO:                              \
  /LINKSERVICE:SNADLC1                        \
  /REMOTEEND:Host                             \
  /CONNTYPE:802.2                             \
  /XIDTYPE:Format3                            \
  /REMOTENETADDR:400070006200                 \
  /REMOTESAPADDR:4                            \
/MAXBTULEN:1929                               \
  /RECEIVEACKTHRESH:2                         \
  /NAKSENDLIMIT:8                             \
  /RETRYLIMIT:10                              \
  /XIDRETRIES:3                               \
  /T1TIMEOUT:Default                          \ 
  /T2TIMEOUT:Default                          \
  /TITIMEOUT:Default                          \
  /ACTIVATEDELAY:Default                      \
  /ACTIVATERETRYLIMIT:None                    \
APPCRLU M1CDXY2B /ADD                         \
  /CONNECTION:TOKEN1                          \
  /NETNAME:CSDNET                             \
  /LUNAME:M1CDXY2B                            \
  /COMMENT:""                                 \
  /UNINTERPNAME:M1CDXY2B                      \
  /AUTOPARTNER:No                             \
  /PARALLELSESS:Yes                           \
APPCLLU M1R01LUA /ADD                         \
  /SERVER:CSD-NTSNA1                          \
  /LUNUMBER:0                                 \
  /NETNAME:CSDNET                             \
  /LUNAME:M1R01LUA                            \
  /COMMENT:""                                 \
  /AUTOPARTNER:No                             \
  /DEFAULTPOOL:No                             \
  /TPTIMEOUT:60                               \
APPCLLU M1R01LUA                              \
  /ADDPARTNER:M1CDXY2B,NDM624K,TOKEN1         \
APPCLLU M1R01LUB /ADD                         \
  /SERVER:CSD-NTSNA1                          \
  /LUNUMBER:0                                 \
  /NETNAME:CSDNET                             \
  /LUNAME:M1R01LUB                            \
  /COMMENT:""                                 \
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  /AUTOPARTNER:No                             \
  /DEFAULTPOOL:No                             \
  /TPTIMEOUT:60                               \
APPCLLU M1R01LUB                              \
  /ADDPARTNER:M1CDXX2B,NDM624K,TOKEN1         \
USER USER1 /ADD                               \
  /DOMAIN:CSD-NTSNA1                          \
  /COMMENT:""                                 \
USER USER1                                    \
  /INSERT:M1R01LU2                            \
USER USER1                                    \
  /INSERT:M1R01LU3                            \
DIAGNOSTIC                                    \
  /AUDITLEVEL:10                              \

Access Communications Server Configuration Listing
The SNA configuration listing for IBM Communications Server is stored in a file with an extension
of acg. The name for this file is defined when you install the Communications Server.

SNA Server/Host Configuration Worksheet
Complete this worksheet before you set up and configure an SNA connection between the host and
the SNA server.

For each parameter listed, record the parameter value mapped between SNA and VTAM. Use the
alphabetic identifier in the first column to understand how the parameters are implemented in the
network map in the example following this table.

Windows/SNA Parameter Value Mapped
Between SNA and VTAM

Host/VTAM

[a] Local Connect:Direct node
name=

LOCAL.NODE

[b] Remote Connect:Direct
node name=

ADJACENT.NODE

[c] Mode= LOGMODE

[d] Session Limits= VTAM APPLID DSESSLIM

[e] Max RU= LOGMODE RU Size

[f] Server Netname= VTAMNETID (owner of PU)

[g] Server CPNAME= VTAM PU Name

[h] Connection CPNAME= VTAM SSCPNNAME

[i] Connection Netname= VTAM NETID (owner of
PU)

[j] Connection
LOCALBLOCKNO=

VTAM PU DBLK

[k] Connection
LOCALNODENO=

VTAM PU IDNUM

[l] Connection
REMOTENETADDR=

Remote Network Address
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[m] Local LU Name
(APPCLU)=

VTAM LU Name (must be
independent)

[n] APPCLU Netname= VTAM NETID (owner of
PU)

[o] Remote Partner LU
(APPCRLU)=

VTAM APPLID

[p] APPRCLU Netname= VTAM NETID (owner of
APPLID)

Get Support for Sterling Products
Sterling Commerce provides intuitive technical products and superior Help and documentation to
enable you to work independently. However, if you have a technical question regarding a Sterling
Commerce product, use the Sterling Commerce Customer Support Web site.

The Sterling Commerce Customer Support Web site at www.sterlingcommerce.com is the doorway
to Web support, information, and tools. This Web site contains informative links, including a solutions
database, an issue tracking system, fix information, documentation, workshop information, contact
information, sunset and retirement schedules, and ordering information. See the Customer Support
Reference Guide for specific information on getting support for Sterling Commerce products.

Connect:Direct for Windows Documentation
The Connect:Direct for Windows library consists of the following manuals:
• Getting Started with Connect:Direct Windows is a guide to installing Connect:Direct Windows. This

book includes pre-installation and installation information and tasks.
• Connect:Direct Windows System Guide is a guide to setting up and using Connect:Direct Windows. This

book also describes administrative concepts for Connect:Direct Windows.
• Connect:Direct Windows Release Notes includes product updates and compatibilities, last-minute

changes, instructions for downloading the product from the ESD Portal, known restrictions,
enhancements, and installation notes.

• Connect:Direct Windows Maintenance Updates contains the latest product maintenance.

The following manuals supplement the Connect:Direct Windows documentation:
• Connect:Direct Process Concepts and Examples Guide provides an overview of Connect:Direct,

describes the general structure and syntax rules for the Process language, and includes numerous
examples.

• Connect:Direct Process Statements Guide describes the Process statements for various platforms
including Connect:Direct.

• Connect:Direct Compatibility and Connectivity Chart provides definitions for the supported
Connect:Direct platforms and the mapping of definitions that must match between two communicating
platforms.

• Connect:Direct for Windows Secure+ Option Implementation Guide provides installation and
configuration information for Secure+ Option.

• Connect:Direct SDK Programmer’s Guide provides system programmers and system developers with
the information needed to extend the capabilities of the Connect:Direct environment.
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Install Connect:Direct for Windows

Install Connect:Direct for Windows: Overview
Once you complete the installation worksheets, you are ready to install Connect:Direct for Windows.
When you perform the installation, you can install all Connect:Direct for Windows components or you
can install selected components. Choose from the following components:
• Connect:Direct for Windows server—Performs the functions issued from the user interface. If

you want a dedicated server, install only this component. It also includes the Command Line
Interface (CLI), a tool that allows you to issue commands to the server.

• Connect:Direct for Windows Requester—A graphical user interface that makes it easy to
configure the Connect:Direct environment, create Processes, and submit commands to the
server.

• Connect:Direct File Agent—A component that scans watched directories for the appearance
of files. When a file is detected in a watched directory, Connect:Direct for Windows either
submits a default Process to Connect:Direct or performs the actions specified by the rules for
the file.

• Connect:Direct Secure+ Option—A separately purchased option that allows you to implement
security into a Connect:Direct operation. Secure+ must be installed on both nodes in order to
activate the security software.

Software Developer’s Kit (SDK) is a separately purchased option that allows programmers to
customize the functions of Connect:Direct for Windows.

After you install Connect:Direct for Windows, the TCP/IP information, database information and
notification method is defined in the initialization parameters. To change TCP/IP information, the
notification type, or the Connect:Direct database, refer to the Connect:Direct for Windows System
Guide.

Connect:Direct for Windows Installation Icons
You choose the installation type to meet your needs. For example, if you want to install a standalone
server, install only the Connect:Direct for Windows server software. If you want to use a computer as
a server and a workstation, install both the server software and Connect:Direct Requester. If you
purchase Secure+ Option, use the custom installation to install both Connect:Direct for Windows and
Secure+ Option.

Additionally, if you have a large network of computers where you need to install Connect:Direct for
Windows, you can set up a silent installation. To configure a silent installation, install Connect:Direct
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for Windows at one computer. Then use the initialization parameters file that was created during the
installation to create a silent installation. Send the modified INI file to each computer on which to
perform the silent installation.

Icons are displayed by each component to illustrate the selected installation type. The icons and
installation types are described below:

The component is installed to the local drive.

Selected features of the component are installed.

The component is not installed.

Adds an icon to the Connect:Direct program group of the selected
computer. The component is only installed when the user clicks the
program icon to run the program.

The component is installed on the network.

Connect:Direct is installed in the directory called X:\Program Files\Sterling Commerce\Connect Direct
v4.5.00\component.
• component is the name of the component being installed. If you would like to install Connect:Direct

for Windows in another location, select the Custom setup type during the installation and click Change
in the setup panel. The remaining procedures use the default installation path.

Obtain and Install a Temporary or Permanent License Key File

The temporary and permanent license key file must be applied on the computer where Connect:Direct
for Windows is installed.

1. Copy the temporary license key file from the Sterling Commerce e-mail to the C:\Program Files
\Sterling Commerce\Connect Direct 4.5.00\server directory.

2. Rename the temporary license key file to license.key.

Do not edit the nnnnn.txt file or the license.key file. Text editors may insert a carriage return or
truncate lines, which will invalidate the key file.

3. To obtain a permanent license key, use the CD System ID Utility. To run the CD System ID
Utility:
• Click Start > Programs > Sterling Commerce Connect:Direct v4.5.00 > CD System ID Utility.

The Connect:Direct System ID Utility main window displays the CPU-ID and number of
processors.

• To save the information, click File > Save.
• Type a name for the file and click Save.
• Click File > Send email.
• Type requested information in the e-mail template and click Send.

You will receive the permanent license key file through e-mail in approximately 24 to 48
hours.

4. Make a copy of the original permanent license key file and keep it in a safe place.
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5. To replace the temporary license key with the permanent license key file, repeat steps 1 and 2.

Start the Installation

To begin the Connect:Direct for Windows installation:

1. Insert the Connect:Direct for Windows CD into the CD drive or double-click the setup.exe file
extracted from the file downloaded from the ESD Portal.

2. If the Autorun option is enabled for the CD drive, the Connect:Direct for Windows installation
setup detects the type of Windows operating system installed on your computer and automatically
starts the installation. If the Autorun option is disabled, do the following:
• Click Start, then click Run.
• On the Run dialog box, click Browse.
• On the Browse dialog box, select the drive mapped to your CD drive from the Look in: field

drop-down box.
• Double-click Setup.exe. The program returns to the Run dialog box.
• Click OK.

3. On the Welcome dialog, click Next.

4. On the License Agreement page, read the agreement and indicate acceptance by clicking "I accept
the terms of the license agreement." Click Next.

Note: If you click "I do not accept...," you must terminate the installation.

5. Do one of the following:
• To install Connect:Direct server and Requester, select Typical. Click Next.
• To install Connect:Direct for Windows and Secure+ Option, select Custom. This is the

preferred installation method. Click Next.

Complete the Typical Installation
This procedure assumes you have started the installation and have selected Typical as the type of
installation you want to perform.

To complete the Connect:Direct for Windows typical installation:

1. Select Default from the Configure Connect:Direct for Windows Server dialog box.

2. Click Browse and select the locate license file that is provided to you by Sterling Commerce.
The license file is copied to the C:\Program Files\Sterling Commerce\Connect Direct
v4.5.00\server folder. Click Next.

3. Configure MySQL to capture statistics, messages, and TCQ information by providing the port
number and password. Click Next.

4. Click Install.
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5. Click OK to continue the installation.

6. The Finish dialog box has a check box for automatically starting the Connect:Direct Requester.
If you do not want to start Connect:Direct Requester, deselect this option. Click Finish.

Complete a Custom Installation
This procedure assumes that you have started the installation and have selected Custom as the type of
installation you want to perform.

To complete a custom installation of Connect:Direct for Windows:

1. After you select Custom and click Next, the Custom Setup dialog box is displayed. The
Connect:Direct for Windows Server and Requester software will be installed automatically.
• MySQL is the default database option. If you plan to use Microsoft SQL Server, you do not

need to install MySQL. Click the icon next to MySQL and select the red X to make this feature
unavailable.

• To install Secure+ Option, click the icon next to Secure+ and identify the type of installation
to perform.

• To install an SNMP extension agent, click the icon next to SNMP Extension Agent to remove
the red X.

2. The default installation path of Connect:Direct for Windows is C:\Program Files\Sterling
Commerce\Connect Direct v4.5.00. If you want to change the installation path:
• In the Custom setup dialog box, highlight Server and click Change. A dialog box is displayed

to allow you to choose a different installation location.
• After you choose the destination location, click OK.

3. After selecting which components to install, click Next.

4. The Configure Connect:Direct for Windows Server dialog box is displayed. Select Custom.

5. The Enter Local Node Name dialog box is displayed showing the name of the local node, which
is defined as the hostname of the computer where you are installing Connect:Direct for Windows.
If you want to use a different local node name, type the alternate node name in the field provided
and click Next.

6. The License Management dialog box is displayed. Click Browse and select the license file which
is provided to you by Sterling Commerce. The license file is copied to the C:\Program Files
\Sterling Commerce\Connect Direct v4.5.00\server folder. Click Next.

7. You are prompted to configure either MySQL or Microsoft SQL Server to capture statistics,
messages, and TCQ information, depending on whether you deselected MySQL as the default
database.
• MySQL—Type the port number and the password and click Next.
• Microsoft SQL Server—Select a SQL Server from the list or click Browse to locate one.

Specify to connect using Windows authentication or Microsoft SQL Server using the specified
User ID and Password.
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8. On the Service Account Information dialog box, you can specify an optional user account to run
the Connect:Direct service. To specify an account, click "Enter an optional service logon
account," enter the following information, and follow by clicking Next.
• Service Account name
• Service Password
• Verify the password

Note: In setting up the logon account, give the account these privileges:
• Act as part of the operating system
• Log on as a service
• Log on locally
• Replace a process-level token
• Full permissions over the installation directory, typically "Program Files

\Sterling Commerce\Connect Direct v4.5.00"
• Make the user a member of the local Administrators Group

9. To configure TCP/IP as the connection method, type or select the following information and
click Next.
• Node-to-Node IP Address
• Node-to-Node Port
• User Interface IP Address
• User Interface Port

10. If you installed SNA, the Enter SNA Information dialog box is displayed. To configure SNA
support:
• Select Configure SNA.
• Type the local LU name in the Local LU Name field.
• Type the network name or ID in the Network Name (NET ID) field.
• Type the mode name in the APPC Mode Name field.
• Click Next.

11. The Register with Active Directory dialog box is displayed. If you want to use Active Directory,
select Register Client Connection Settings and click Next.

12. The SNMP and Event Logging dialog box is displayed. To configure SNMP support:
• To enable the SNMP extension agent, select Enable Connect:Direct SNMP Extension Agent.
• To enable event logging, select Enable SNMP Event Logging.
• Click Next.

13. The Notifications dialog box is displayed. To configure notification support:
• To enable Windows broadcasting, select NT Network Broadcast.
• To enable SMTP, select SMTP.
• Click Next.

14. The Imported Configurations Files dialog box is displayed. To use a network map or user
authorities that you defined for previous versions of Connect:Direct, click Browse and select the
network map to import or the user authority configuration file to import. Click Next.
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15. The Ready to Install the Program dialog box is displayed. Click Install. A message informs you
that Connect:Direct for Windows is being installed.

16. If you installed Connect:Direct Requester, the Finish dialog box has a check box that
automatically starts Connect:Direct Requester. If you do not want to start Connect:Direct
Requester, deselect this option. Click Finish.

Upgrade Installation

This procedure assumes that you have started the installation and have selected Upgrade as the type
of installation you want to perform.

Do the following:

1. Select a node to upgrade in the Installed Nodes drop-down list. Click Next to continue.

2. If you are upgrading from Connect:Direct for Windows 4.2.00 or earlier, an information box is
displayed stating, “MS-Access database is no longer supported. The Access database will be
migrated to MySQL Server.” Click OK to continue.

3. If you are upgrading from Connect:Direct for Windows 4.4.00 or later, the Configure MySQL
Server dialog box is displayed. Configure MySQL by providing the port number and password.
Click Next.

4. Within the Upgrade Connect:Direct Options panel, you can choose to keep the previous version
by checking the option "Keep <version - nodename>." Optionally, you can choose to upgrade
the previous version to the current one by leaving the box unchecked. Click Next.

5. The Ready to Install the Program panel is displayed. Click Install. A message informs you that
Connect:Direct for Windows is being installed.

6. The Finish dialog panel has a check box for automatically starting the Connect:Direct Requester.
If you do not want to start Connect:Direct Requester, deselect this option. Click Finish.

Add Connect:Direct for Windows Components
Before performing this procedure, first you must have installed Connect:Direct for Windows.

After you install Connect:Direct for Windows, you can change the features you installed including
repairing a component that has become corrupted, removing an installed component, or installing an
additional component. After you install Connect:Direct the first time, future installation attempts
identify this as a second installation.

To add, remove, or repair a Connect:Direct component, do the following:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next to continue.

3. To install additional Connect:Direct for Windows components, do the following:
• Select Modify to install an additional Connect:Direct component and click Next.
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• Select the component to add, choose "This feature will be installed on local hard drive," and
click Next.

• Click Install.
• Click Finish to complete the modification.

Repair Connect:Direct for Windows Components
Before performing this procedure, first you must have installed Connect:Direct for Windows.

To repair Connect:Direct for Windows components:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next.

3. Select Repair and click Next

4. Click Install to repair the installation.

5. Click Finish to complete the modification.

Remove Connect:Direct for Windows Components
Before performing this procedure, first you must have installed Connect:Direct for Windows.

To remove a Connect:Direct for Windows installed component:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next.

3. Select Modify to remove a Connect:Direct component and click Next.

4. Select the component to remove, choose "This feature will not be available," and click Next.

5. Click Install.

6. Click Finish to complete the modification.

Install Requester Only

For cluster installations, computers other than the one on which Connect:Direct is installed may require
that the Requester be installed.

This procedure is for installing Requester only.

To install Connect:Direct Requester:

1. Insert the Connect:Direct Requester CD into the CD drive or double-click the setup.exe file
extracted from the file downloaded from the ESD Portal.
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2. If the Autorun option is enabled for the CD drive, the installation setup detects the type of
Windows operating system installed on your computer and automatically starts the installation.
If the Autorun option is disabled, do the following:
• Click Start, then click Run.
• On the Run dialog, click Browse.
• On the Browse dialog, select the drive mapped to your CD drive from the Look in: field drop-

down box.
• Double-click Setup.exe. The program returns to the Run dialog box.
• Click OK.

3. On the Welcome dialog, click Next.

4. On the License Agreement page, read the agreement and indicate acceptance by clicking "I accept
the terms of the license agreement." Then click Next.

Note: If you click "I do not accept...," you must terminate the installation.

5. On the Setup Type dialog, select Typical and click Next.

6. Click Install.

Install Connect:Direct File Agent

When you install Connect:Direct File Agent, Java Runtime Environment (JRE) is automatically
installed.

To install File Agent:

1. Insert the Connect:Direct for Windows CD into the CD drive, or locate the files you extracted
from the ESD Portal, and double-click the FileAgentInstall.exe file.

2. From the Introduction dialog box, click Next.

3. If you want to install File Agent in a selected location, click Choose and identify the location for
the File Agent installation.

4. Click Next, then click Install.

5. When the installation is complete, click Done.

Uninstall Connect:Direct for Windows
Before performing this procedure, first you must have installed Connect:Direct for Windows.

The Connect:Direct for Windows Uninstall program removes the application, its components,
Connect:Direct Requester, and Connect:Direct for Windows server, program items, and most server
and Registry settings.

To uninstall the Connect:Direct Server program and all of the server utilities, perform the following
steps:
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1. Click Start > Programs > Settings > Control Panel > Add-Remove Programs.

2. Highlight Connect:Direct for Windows and click Remove.

3. Click Yes to confirm the removal of this program.

4. Click Finish to complete the uninstallation.

5. Click OK to close the Add/Remove Programs Properties dialog box.

Add Initialization Parameters to Support Firewall Navigation

If you communicate with a trading partner using a firewall, set two initialization parameters to support
it. You assign a specific TCP/IP source port number or a range of port numbers with a particular TCP/
IP address or addresses for outgoing Connect:Direct sessions. Setting these parameters allows
controlled access to a Connect:Direct server if it is behind a packet-filtering firewall without
compromising security.

To add firewall support initialization parameters:

1. Coordinate IP addresses and associated port assignments with your firewall administrator.

2. Add the following parameter to the Local Node Characteristics section of the initialization
parameters file:

tcp.src.ports=(valid IP address/optional subnet mask | valid IP address pattern, associated port
number | associated range of port numbers | associated port number, associated range of port
numbers)

3. Apply the new initialization parameter.

4. A second parameter called tcp.src.ports.list.iterations is automatically added to the Local Node
Characteristics section during installation and has a default value of 1. Refer to the following
table for a description and valid values for these parameters:

Parameter Name Parameter Definition Valid Values

tcp.src.ports An IP address or multiple addresses
and the ports permitted for the
address when going through a
packet-filtering firewall.

Valid IP address with an optional
mask for the upper boundary of the
IP address range and the associated
outgoing port number or range of port
numbers for the specified IP address,
for example:

(199.2.4.*, 1024),
(fd00:0:0:2015:*::*, 2000-3000),
(199.2.4.0/255.255.255.0,
4000-5000),(fd00:0:0:2015::0/48,
6000, 7000)

A wildcard character (*) is supported
to define an IP address pattern. If the
wildcard character is used, the
optional mask is not valid.
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Parameter Name Parameter Definition Valid Values

tcp.src.ports.list.iterations The number of times that
Connect:Direct scans the list of
available ports defined in
tcp.src.ports to attempt a connection
before going into a retry state. This
parameter is automatically added to
the initialization parameter and is
assigned a value of 1. If desired,
change this value.

A numeric value from 1-255. The
default value is 1.

5. Coordinate the specified port numbers with the firewall administrators.

Firewall Configuration Example
The following example illustrates a configuration of the firewall navigation initialization parameter.
An explanation follows the example. Although the tcp.src.port parameter is shown as a multi-line
parameter, Connect:Direct for Windows only supports single-line parameters.
tcp.src.ports=    (199.2.4.*, 5000-5050),
                        (199.2.4.7, 1376),
                        (200.200.0.0/255.255.0.0, 2000-2100, 3000-3100),
                        (138.16.17.*, 2000-2050, 3000-3050, 4001, 4005)    

In the example, if Connect:Direct initiates a session with a remote node at the IP address 199.2.4.7, it
will use only port 1376. A session 199.2.4.6 (or any other address beginning with 199.2.4) will use
any port in the range 5000 to 5050.

A session to 200.200.4.10 uses a port from within the two ranges specified (2000 to 2100 or 3000 to
3100). Additionally, because of the subnet mask specification, a session to any IP address beginning
with 200.200 will choose a port from within the two ranges specified.

The port for a session to any address beginning with 138.16.17 is selected from one of the two ranges
(2000 to 2050 or 3000 to 3050) or the two individual ports specified (4001 or 4005).

30 Sterling Commerce, Inc.



Chapter 3

Automate Installation

About Silent Installations
You can automate Connect:Direct for Windows installation and configuration for distribution
throughout your enterprise by performing silent installations. Silent installations require no user
responses during the installation routine. Configuration information is supplied by the initialization
file that you define. Before you perform a silent installation, install Connect:Direct for Windows on a
master node and configure a network map and user authorizations.

The Microsoft Installer Properties are the foundation of a silent installation. Properties can be set on
the command line or by creating custom transforms. A transform is a collection of changes applied to
an installation. Transforms alter the installation database and can be used to customize a base
installation package. Applying a transform to a base installation package adds or replaces data in the
installation database.

Silent Installation Options
You can perform a default silent installation that installs Connect:Direct server and Connect:Direct
Requester, or you can use transforms to modify the settings of an installation package. The transforms
included with this product enable, disable, and remove a feature from the Connect Direct for
Windows.msi package. To change the silent installation setting, use a transform to enable or disable
the desired feature.

Requirements for Silent Installation
Use the following list as a guide to the silent installation requirements for each node:
• To perform the default installation (server and Connect:Direct Requester), the node must have

a license key.
• To install only Connect:Direct Requester or SDK, no license key is required.
• If the node uses special services, for example, Active Directory, SNMP, or SNA, a custom INI

file is required. If no custom INI file is present, the default installation is performed.

Customize Initialization Information for a Silent Installation
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The Connect:Direct server supports an INI file, which can specify the value of installation properties.
If you plan to use the INI file to manage a silent installation, change the parameters of the INI file
provided with Connect:Direct for Windows to specify site-specific information.

The Connect:Direct for Windows server initialization file (CD_SRVR.INI) is located on the CD in
the /advanced folder. The Connect:Direct Requester and SDK installations do not use initialization
files. To set the installation directory for an installation, specify the INSTALLDIR property in the
command line.

To define site-specific parameter values in an INI file for each node where you install Connect:Direct
for Windows using the silent installation, do the following:

1. Open the CD_SRVR.INI file using any text editor, such as Windows Notepad.

2. Define the site-specific initialization parameters for a node and save the file.

3. Repeat steps 1–2 for each server where Connect:Direct will be installed.

CD_SRVR.INI Parameter Values

Parameter Name Parameter Definition Values

CD_SETUP_TYPE The installation type: Default,
Custom, or Upgrade.

Default | Custom | Upgrade

CD_SQL_AUTHENTICATION SQL authentication.

CD_MYSQL_PORT Port for MySQL database.

CD_MYSQL_PWD Password for MySQL database
access.

CD_NodeName The local node name, from 1-16
characters, consisting of numbers,
letters, @, #, $, -, underscore (_), and
period (.) with no spaces or
apostrophes.

If this field is blank, the parameter
defaults to the first eight characters
of the computer where the server is
being installed.

CD_UPGRADE_NODE The version of software and node to
upgrade.

Version of software to update and the
name of the node in the format
Vx.xx.xx\nodename where x.x.xx is
the version number

CD_NODE_CHECK

CD_UPGRADE_KEEPSCR_FLAG Identifies if the current
Connect:Direct will be version
uninstalled before upgrading to the
new version.

1=enabled

This variable applies only if
CD_SETUP_TYPE=UPGRADE

CD_LICENSE_FILE The path name to the license file
(license management key).

X:\Program Files\Sterling Commerce
\Connect Direct \x.x.xx | Any valid
Windows directory

CD_HOST_IP The IP address of the host server. Any valid IP address.

CD_HOST_PORT The port number that Connect:Direct
for Windows, or user-written API
programs, will use to establish client
sessions with this Connect:Direct
server for outgoing communications.

A numeric value in the format nnnn,
where nnnn is a positive integer no
larger than four digits. The default is
1364.
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CD_SRVR.INI Parameter Values

Parameter Name Parameter Definition Values

CD_API_IP The host IP address. Any valid TCP/
IP address may be specified.

Valid TCP/IP address. If blank, the IP
address is obtained from the
destination computer’s IP address in
the TCP/IP stack.

CD_API_PORT The port number that Connect:Direct
for Windows or user-written API
programs will use to establish client
sessions with this Connect:Direct
server. You must specify the port
when it differs from the default.

A numeric value in the format nnnn,
where nnnn is a positive integer no
larger than four digits. The default is
1363.

CD_SNA_FLAG Indicates whether SNA connectivity
is supported.

1=enabled

CD_SNA_LUNAME The local LU name to use during SNA
communications, or the name of the
computer, if no LU name is specified.

Valid 1-8 character LU name or
computer name up to 8 characters.

CD_SNA_NETID The SNA network ID. A valid 1-8 character network ID.

CD_SNA_MODE The SNA mode name. ndm624K | a valid 1-8 character
mode name

CD_SNMP_FLAG Enables SNMP. 1=enabled

CD_EVENTLOG_FLAG Enables SNMP Event log. 1=enabled

CD_ACTIVEDIR_FLAG Registers the client IP address to
active directory.

1=enabled

CD_NOTIFY_TYPE Defines the notification type to use. NT Broadcast | SMTP

CD_NOTIFY_SMTP_HOST If CD_NOTIFY_TYPE = SMTP, this
field identifies the IP address of the
SMTP host.

Host address in the format
xxx.xxx.xxx

CD_NOTIFY_SMTP_PORT If CD_NOTIFY_TYPE = SMTP, this
field identifies the port used by the
SMTP host.

Port number up to four characters.
The default value is 25.

CD_NOTIFY_SMTP_SENDER If CD_NOTIFY_TYPE = SMTP, this
field identifies the e-mail address to
identify the sender of the message

Valid e-mail address

CD_NOTIFY_SMTP_AUTHENTICA
TE

If CD_NOTIFY_TYPE = SMTP, this
field enables authentication. If this
value is not set, the user ID and
password fields are ignored.

1=enabled

CD_NOTIFY_SMTP_USERID If CD_NOTIFY_TYPE = SMTP, this
field identifies the user ID to use to
authenticate the server.

A valid user ID.

CD_NOTIFY_SMTP_PWD If CD_NOTIFY_TYPE = SMTP, this
field identifies the user password to
use to authenticate the server.

A valid user password.

CD_USERAUTH_FILE The path name and file name to the
user authority file.

X:\Program Files\Sterling Commerce
\Connect Direct \x.x.xx
\MyUserAuthSettings.cfg | Any valid
Windows directory and user authority
file name
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Parameter Name Parameter Definition Values

CD_NETMAP_FILE The path name and file name of the
network map file.

X:\Program Files\Sterling Commerce
\Connect Direct \x.x.xx
\mynetmap.map | Any valid Windows
directory and network map file name

CD_NETMAP_CHECK

CD_SVC_ACCOUNT Connect:Direct service user account.

CD_SVC_ACCOUNT_PWD Connect:Direct service user account
password.

CD_DATABASE_TYPE The type of database to use. MYSQL | MSSQLSS (SQL Server -
Windows Authentication)| MSSQLIS
(SQL Server - Mixed Mode)

CD_SQL_SERVER The name of a valid SQL Server.
Note: This variable is required only if
CD_DATATBASE_TYPE is
MSSQLSS or MSSQLIS. Two types
of SQL Server validation are used:
SQL Server with Windows
Authentication or SQL Server - Mixed
Mode Authentication. Integrated
security with Windows authentication
requires the server name and mixed
mode security requires the server
name, user name and password.

Valid SQL Server Name

CD_SQL_USERID The SQL Server system
administrator’s user ID.

Valid SQL Server System
Administrator user ID

CD_SQL_PWD The SQL Server system
administrator’s password. Note: This
variable is required only if the
CD_DATATBASE_TYPE is
MSSQLSS.

Valid 1-30 character SQL Server
System administrator password

Customize Connect:Direct for Windows Configuration Information
After you install Connect:Direct for Windows on a master node, you can customize configuration
information for distribution within your enterprise by using Connect:Direct Requester to configure the
network map and user authorizations on the master node. You can then extract those files using the
Configuration Utility. For more information about using the Configuration Utility, refer to "Defining
and Managing the Connect:Direct Network" in Help or in the Connect:Direct for Windows System
Guide.

To apply the customized configuration files during a silent installation, set parameter values in the
CD_SRVR.INI file as follows:
• To apply a customized network map file, set CD_NETMAP_FILE to the fully qualified path

to a customized network map configuration file.
• To apply a customized user authorization file, set CD_USERAUTH_FILE to the fully qualified

path to a customized User Authorization configuration file.
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Run a Silent Installation

Setup.exe installs the Microsoft Installer, Visual C++ Runtime Libraries and other prerequisites on a
system when they do not already exist. To complete the installation, Setup.exe reboots the system if
required and resumes the installation after the computer has restarted.

Setup.exe can accept a limited number of command-line parameters. By using these parameters, you
can pass parameters through Setup.exe to the included .msi file (MsiExec). To pass arguments to
the .msi file, use the /v option. Once you specify this option, you can list any of the supported parameters
that can be passed to Msiexec.exe.

If you don't want the Setup.exe to display a progress bar when it launches, use the /s command-line
parameter. For example, if you enter Setup.exe /s, Setup.exe launches, but the user interface is not
displayed. If you want the .msi setup to run silently as well, you'll need to pass the /qn command-line
parameter through Setup.exe using the /v parameter—for example: Setup.exe /s /v/qn

Follow these special formatting rules when passing a parameter in this way. First, place a backslash
(\) character before a quotation mark that resides within existing quotes. For example, the command
line above contains the following: /v"C:\My Files\SecurePlusEnable.mst\". Because the path contains
spaces, you must use quotes. However, since quotes are required around the complete argument, if you
don't use the backslash before internal quotes, the command-line statement fails.

Do not put a space between the command-line option (/v) and the arguments you are passing. This rule
is also illustrated in the above example.

Finally, if you are passing multiple parameters using the /v option, separate them with a space. For
example, the following command enables Secure+ Option and specifies the license file:

Setup.exe /s /v"C:\My Files\SecurePlusEnable.mst\" CD_LICENSE_FILE=\"C:\My Files\license.key
\""

To attach to the network and install Connect:Direct for Windows features from the network location
in a silent installation:

1. Click Start > Run. The Run dialog box is displayed.

2. In the Open field of the Run dialog box, type a command similar to following example: Setup.exe /
s /v/qn

This command installs all Connect:Direct for Windows components including Connect:Direct
Requester and Secure+ Option.

Note: Setup.exe installs Connect:Direct for Windows in the default directory c:\Program
Files\Sterling Commerce\Connect Direct Windows v[current version]. If you want
to install Connect:Direct for Windows in a different directory, use the
INSTALLDIR option on the command line. Enclose the pathname in quotes and
terminate the path with a backslash, such as Setup.exe /v"INSTALLDIR=\"D:
\Program Files\Sterling Commerce\Connect Direct v4.5.00\"" .

3. Computers in a Windows 2000 or XP Domain that use Active Directory can also automate
installations using the software installation extension of the Group Policy Snap-In.

The Windows installer uses an /M command line parameter to generate MIF files. In the following
example, the CDNT.mif file is created to report success or failure: setup.exe /s /v/qn /M C:
\Windows\CDNT.mif
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Perform an Unattended Uninstallation

Connect:Direct for Windows provides for an unattended uninstallation. In the following example, the /
x command parameter removes the package.

Setup.exe /x
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52.227-14(g)(2)(6/87), and FAR 52.227-19(c)(2) and (6/87), and where applicable, the 
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commercial software and commercial software documentation including DFAR 252.227-
7013(c) (1), 252.227-7015(b) and (2), DFAR 252.227-7015(b)(6/95), DFAR 227.7202-3(a), all 
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that Sterling Commerce intends to make these available in all countries in which Sterling 
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Printed in the United States of America 
 
WARRANTY DISCLAIMER 
The Sterling Commerce Software and the related documentation are licensed either "AS IS" or 
with a limited warranty, as described in the Sterling Commerce license agreement.  Other than 
any limited warranties provided, NO OTHER WARRANTY IS EXPRESSED AND NONE 
SHALL BE IMPLIED, INCLUDING THE WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR USE OR FOR A PARTICULAR PURPOSE. The applicable Sterling 
Commerce entity reserves the right to revise this publication from time to time and to make 
changes in the content hereof without the obligation to notify any person or entity of such 
revisions or changes. 
 
As set forth in the README file located at <Connect:Direct installation directory>\Server 
(“Read Me file”), certain of the Third Party Licensors assert specific terms with respect to their 
respective products.  Such terms shall only apply as to the specific Third Party Licensor product 
and not to those portions of the product derived from other Third Party Licensor products or to 
the Sterling Commerce Software as a whole.  Except as otherwise described in the README 
file, the Third Party Software is provided 'AS IS' AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE  ARE 
DISCLAIMED.  Additionally, certain Third Party Licensor product terms and information are 
set out below.  Such terms shall only apply as to the specific Third Party Licensor product and 
not to those portions of the product derived from other Third Party Licensor products or to the 
Sterling Commerce Software as a whole. 
 
 
OPEN SSL SOFTWARE 
 
The Sterling Commerce Software is distributed on the same storage media as the OpenSSL 
Software  version 0.9.7m.  The OpenSSL Software is subject to the following license terms: 
 
 
 "The OpenSSL toolkit stays under a dual license, i.e. both the conditions of  the OpenSSL 
License and the original SSLeay license apply to the toolkit.  See below for the actual license 
texts. Actually both licenses are BSD-style  Open Source licenses. In case of any license issues 
related to OpenSSL  please contact openssl-core@openssl.org. 
 
  OpenSSL License 
  --------------- 
 
 Copyright (c) 1998-2007 The OpenSSL Project.  All rights reserved. 
 
 Redistribution and use in source and binary forms, with or without modification, are permitted  
provided that the following conditions are met: 
  
  1. Redistributions of source code must retain the above copyright notice, this list of conditions  
and the following disclaimer. 
  
 2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 
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 3. All advertising materials mentioning features or use of this software must display the 
following acknowledgment: 
    "This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)" 
 
 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact openssl-core@openssl.org. 
  
 5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" 
appear in their names without prior written permission of the OpenSSL Project. 
  
 6. Redistributions of any form whatsoever must retain the following acknowledgment: 
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL  
Toolkit (http://www.openssl.org/)" 
 
  THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR  
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED  
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION)HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 
 ==================================================================== 
 
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).  
This product includes software written by Tim Hudson (tjh@cryptsoft.com). 
 
 
 Original SSLeay License 
 ----------------------- 
 
 Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. 
 
 This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). 
The implementation was written so as to conform with Netscapes SSL. 
 
This library is free for commercial and non-commercial use as long as the following conditions 
are adhered to.  The following conditions apply to all code found in this distribution, be it the 
RC4, RSA, lhash, DES, etc., code; not just the SSL code.  The SSL documentation included 
with this distribution is covered by the same copyright terms except that the holder is Tim 
Hudson (tjh@cryptsoft.com). 
 
Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be 
removed. If this package is used in a product, Eric Young should be given attribution as the 
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author of the parts of the library used. This can be in the form of a textual message at program 
startup or in documentation (online or textual) provided with the package. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
 1. Redistributions of source code must retain the copyright notice, this list of conditions and the  
following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 
3. All advertising materials mentioning features or use of this software must display the 
following acknowledgement: 
    "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" 
The word 'cryptographic' can be left out if the routines from the library being used are not 
cryptographic related :-). 
4. If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: "This product includes software 
written by Tim Hudson (tjh@cryptsoft.com)" 
 
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 
  
The license and distribution terms for any publicly available version or derivative of this code  
cannot be changed.  i.e. this code cannot simply be copied and put under another distribution 
license  [including the GNU Public License.] 
  
ORACLE CORPORATION 
 
The Sterling Commerce Software is distributed with or on the same storage media as the Oracle 
Help for Java Software provided by Oracle Corporation, Copyright (c) 1996, 2004 Oracle 
Corporation (“Oracle Software”).  The License relating to the Oracle Software is included in the 
directory file located at: <Connect:Direct installation dir>\server\ORACLE.TXT.  Such license 
applies only to the Oracle  
 
Software which is the subject of such directory and does not apply to the Sterling Commerce 
Software or to any other Third Party Software. 
 
Restricted Rights 
The Oracle Software is provided under restricted rights.   If you are (or if you distribute a 
license to) the United States government, the Oracle Software, including documentation, shall 
be considered commercial computer software and you will place a legend, in addition to 
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applicable copyright notices, on the documentation, and on the media label, substantially similar 
to the following: 
 
NOTICE OF RESTRICTED RIGHTS 
Programs delivered subject to the DOD FAR Supplement are 'commercial computer software' 
and use, duplication, and disclosure of the programs, including documentation, shall be subject 
to the licensing restrictions set forth in the applicable Oracle license agreement.  Otherwise, 
programs delivered subject to the Federal Acquisition Regulations are 'restricted computer  
software' and use, duplication, and disclosure of the programs, including documentation, shall 
be subject to the restrictions in FAR 52.227-19, Commercial Computer Software-Restricted 
Rights (June 1987).  Oracle Corporation, 500 Oracle Parkway, Redwood City, CA  94065. 
 
SUN MICROSYSTEMS SOFTWARE 
 
SUN, Sun Microsystems, Solaris, Java, Jini, Forte and iPlanet and all related trademarks,  
service marks logos and other brand designations that are referred to or displayed in  
the Sterling Commerce Software or the related documentation are trademarks or registered 
trademarks of Sun Microsystems, Inc.  
 
The Sterling Commerce Software is distributed on the same storage media as the JAVA (tm) SE  
Runtime Environment (JRE), Version 6, Copyright © 1999-2006 Sun Microsystems, Inc. ("Sun 
JRE Software"). All Rights Reserved.   
 
The license terms for the Sun JRE Software are located at <Connect:Direct installation  
directory>\jre\LICENSE.  Additional copyright notices and license terms applicable to portions 
of the  
Sun JRE Software are set forth in the THIRDPARTYLICENSEREADME.txt file.  In addition 
to any terms and conditions of any third party opensource/freeware license identified in the  
THIRDPARTYLICENSEREADME.txt file, the disclaimer of warranty and limitation of 
liability provisions in paragraphs 5 and 6 of the Binary Code License Agreement located at 
<Connect:Direct installation directory>\jre\LICENSE shall apply to all Sun JRE Software in 
this distribution.  
 
If [Sun JRE] Software is being acquired by or on behalf of the U.S> Government or by a U.S.  
Government prime contractor or subcontractor (at any tier), then the Government's rights in 
[Sun JRE] Software and accompanying documentation will be only as set forth in this 
agreement; this is in accordance with 48 CFR 227.7201 through 227.7202-4 (for Department of 
Defense (DOD) acquisitions) and with 48 CFR 2.101 and 12.212 (for non-DOD acquisitions). 
 
UDT SOFTWARE 
 
The Sterling Commerce Software includes UDT 3.3 software (the file name of the 
product downloaded from SourceForge.net is UDT.SDK.3.3.bsd_lic.tar[1]) licensed by 
the Board of Trustees of the University of Illinois ("UDT Software").  Other versions of 
UDT 3.3 were licensed under the LGPL.  The UDT Software is subject to the following 
license terms: 
 
Copyright © 2001-2007, The Board of the Trustees of the University of Illinois.  All 
rights reserved. 
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Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
 

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

• Redistributions in binary form must reproduce the above copyright notice, this 
list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

• Neither the name of the University of Illinois nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT NOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING , BUT NOT LIMITED TO, THE IMIPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTIRBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SEPCIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMTED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CUASED AND NO ANY THEORY OF LIABILITY, WHETHR IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
ZLIB SOFTWARE 
 
The Sterling Commerce Software is distributed on the same storage media as the ZLIB software 
version 1.2.3. 
 
zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.3, July 18th, 2005 
 
  Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler 
 
  This software is provided 'as-is', without any express or implied warranty.  In no event will the 
authors be held liable for any damages arising from the use of this software. 
 
  Permission is granted to anyone to use this software for any purpose,  including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions: 
 
  1. The origin of this software must not be misrepresented; you must not claim that you wrote 
the original software. If you use this software in a product, an acknowledgment in the product 
documentation would be appreciated but is not required. 
  2. Altered source versions must be plainly marked as such, and must not be misrepresented as 
being the original software. 
  3. This notice may not be removed or altered from any source distribution. 
 
  Jean-loup Gailly jloup@gzip.org 
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  Mark Adler madler@alumni.caltech.edu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Connect:Direct is a registered trademark of Sterling Commerce.  All Third Party Product names are 
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